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Tutorial Three:

Ozone Fading 
of Inkjet Prints

For this project, use a standard WIR target produced on a glossy paper 
using dye-based ink and custom-made profile.  Expose the samples to 5ppm 
of ozone in a protected, dark environment at 23˚C and a relative humidity of 
50%.  The samples have dimensions of 15 rows by 9 columns.  The Examples 
folder contains i-Star screen captures of the initial target and necessary data 
for this example.  The purpose of this project is to analyze and quantify the 
deterioration of the print as a result of ozone exposure.

Initially, collect the necessary data using an appropriate tool.  The spectral 
data supplied in the Examples folder has been collected using the Gretag Mac-
beth Spectrochart Lite software and the Gretag Macbeth Spectrolino spectro-
photometers.  Because spectral data is supplied, instructions for data collec-
tion are omitted.  Guidance for data collection can be found in corresponding 
manuals for chosen instruments and software.

Now, begin the project.

Start i-Star
Create a new project.

Press Ctrl + n or choose “New Project” in the “Project” menu.  A request 
for a reference measurement will appear.  This measurement is considered 
the “ideal” or starting point.  In this case, choose the measurement marked 
as “_000” for the reference measurement.  Locate the “WIRv3 Ozone Fading 
Example” sub folder in the Examples folder on your install disk for all project 
related files.  See (Fig. 1).

Choose “sn17717_mn000_ms.xls” in the open file dialog. 

Fig. 1
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i-Star will process and report the file on the “Data Layout” page.  A warn-
ing will appear requiring specific information.

This warning means the data collecting software did not report the num-
ber of columns and rows in the output file.  Fill in the “Number of Rows” 
and “Number of Columns” fields.  See (Fig. 2).  The originating data targets 
contain 15 rows and 9 columns each.  The target reading sequence is left-to-
right.

Enter the number of rows and columns in the appropriate fields.
Select “left-to-right” in the Reading Sequence radio group.

The “Examples” folder contains i-Star screen captures of the initial target 
and the data necessary for this example.  

Press “Proceed” button.

i-Star will interpret the data contained in the file and evaluate the param-
eters for all predefined regions of interest.  Unless the option is disabled, a 
message to check (and possibly reassign) the color map values of the target 
will appear.  See (Fig. 3).

The color map values may be changed on the “Project Color Map” tab of 
the “Preferences” page.

Fig. 2
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Press F2 or choose “Preferences” in the i-Star menu.
Navigate to “Project Color Map” tab.

i-Star has several ways of interpreting extreme values of L.  Ideally, with 
images representing the entire L band, readings of L values range between 0 
and 100.  In reality, only values close to these are achievable.  The first option, 
“Defined by user,” allows manual setting of these values reasonable for the 
test.  “Defined by image” will analyze the image and assign values automati-
cally.  Finally, “Defined by map,” analyzes a percentage of patches from the 
target for each L extreme and computes a mean value.  Depending on prefer-
ences and the necessity for repetition of the test, choose one setting.  Keep 
in mind, only the first and last choices offer a basis for cross-examination of 
projects.  See (Fig. 4).

In this example, use the “Defined by map” option and calculate the Lmin 
and Lmax values from the first percentile of extreme L values.

Fig. 3

Fig. 4
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Because the remaining files have the same geometry as the initial file, acti-
vate the Data Import Assumptions (DIA) engine.  Make note, though, that the 
default selection of the DIA engine is the left-to-right reading sequence.  In 
this example, mark this option in the Sequence Assumption radio group.  The 
DIA engine makes assumptions about the size and measuring parameters of 
the “import to” targets based on the reference file for the i-Star project.  Con-

Choose “Defined by map” for both black and white patches. 
Click “Mark Extreme” button for a value of 1%.
Apply changes.

Next, define an area of neutral patches.  Notice a predefined region of inter-
est containing near neutrals and neutrals.  This region, however, does not cor-
respond with patches intended as grey on the target.  Create a “Neutral Rows” 
custom crop to include all of these patches.  The grey areas on the target are 
the first, sixth, and eleventh rows.

Navigate to “Project Info” tab.
Select an empty entry in “Custom Crop” drop down list.
Select the first row in the target and press “Mark selected” button.  Repeat 

this for the sixth and eleventh rows of the target.
Press “Apply Changes” button, and when prompted for a name of the new-

ly created custom crop, enter “Neutral Rows.”

Fig. 5
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sequently, before employing  DIA, verify that the data is compatible.  Data 
may not be compatible if it was gathered using different measuring devices of 
software.  The check boxes in the “Data import options” section will assist in 
verifying that the data meets the necessary criteria for accurate comparison.  
See (Fig. 6).

Navigate to “Data import options” sub-tab on “General” tab.
Activate all assumptions and select the sequence of patches for top-to-bot-

tom.
Deactivate “Import only user confirmed data” option. 

Activation of the “Import only user confirmed data” option allows for ad-
ditional modifications from the “Data Layout” page after the completion of 
the DIA engine cycle. 

Next, test specific information is adjusted.  As mentioned earlier, the sam-
ples were continuously exposed to 5ppm of ozone in a protected environment 
at a temperature of 23˚C and relative humidity of 50%.  Adjust this informa-
tion on the “Permanence” tab.  See (Fig. 7).

Navigate to “Permanence” tab.
In “Test Conditions” group box enter 5 for the gas concentration value, 23 

for the temperature, 50 for the humidity, and leave the remainder of values 
unchanged.  Change the gas fading adjustment value to 1095.

Fig. 6
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There is no need to change the Light cycle value for this project because 
the samples were exposed to light 24 hours a day.  The default values in the 
“Predictions for” box mean that the target is expected exposure to no light in 
normal conditions of 23°C and 50% relative humidity at a fixed ozone level.  
The adjustment factor is a linear function of the ozone exposure level, and 
some sample values are offered as suggestions for this text box.

Next, specify more project information.  For this example, use the dummy 
data.  See (Fig. 8).  Real data in subsequent tests will provide future refer-
ence.  

 
Navigate to “Project Info” tab.
Enter “My Spectrometer” for output device, “Some Ink” for ink set, “Some 

Paper” for media, and “High Intensity Ozone Exposure” for the test condition 
value.

Note that additional data and other project specifics may be included in the 
box underneath.  Examples of such notes are any abnormalities  related to the 
test (e.g. light intensity and temperature fluctuations), side effects to the ink 
set or the printing medium (e.g. ink bleeding or granulation, aberrations and 
changes of the printing medium, etc.), and anything else considered important 
regarding the project.

Fig. 7
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A completion notice will appear.  See (Fig. 10).

Return to “Project Description” page.
Press F2 or choose “Preferences” in the i-Star menu.

Because i-Star calculates results based on the parameters set on the “Pref-
erences” page, any data-related parameter change requires a recalculation.  
Because the color map was modified, recalculate the averaged data for the 
project.  See (Fig. 9).

Press F7 or select “Recalculate Project” in “Project” menu. 

Fig. 8

Fig. 9

Fig. 10
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Now that all files have been imported, the data is ready for analysis.  Be-
fore analysis, though, check the “Target Model” window.  This window shows 
the visual representation of imported data and must look exactly like the target 
used for collecting the data.  See (Fig. 12).

Press Ctrl + a or choose “Add to Project” in “Files” menu.
Choose “sn17717_mn001_ms.xls” in the open file dialog. 

i-Star will process the file and report on the “Data Layout” page.  Return to 
the “Project Description” page.

Numerically add the remaining project files into the folder.

Now, enter the timer values for these measurements in the i-Star “Project 
Description” page.  The time intervals between measurements were respec-
tively, one, one, two, one, two, and four hours.  See (Fig.11).

  
Navigate to “Project Description” tab of the Main i-Star window.
Enter the values one, one, two, one, two, and four in the second through 

seventh rows of the “Timer Stopped” column.

Fig. 11
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Press Ctrl + t, or select “Target Model Window” in the “View” menu.
Press “g.”

The target window now shows the reference target, i.e. the original mea-
surement of the print.  This window offers a number of controls all described 
in the i-Star User Guide.  The first control changes the file (and the corre-
sponding target) represented by the image on the screen.

 
The grid on the “Target Model” window can be turned on or off any time. 

To toggle the appearance of the grid, press “g.”  Change the view to the last 
measurement and a direct comparison of skin tone patches will appear from 
before and after the test.  Because the grid improves visibility of the target, 
leave the target model grid visible.

Next, view the target model for the last print in the series.
Select “sn17717_mn006.xls” in the first drop down list.  See (Fig. 12).

The second drop down list changes the region of interest/custom crop rep-
resented in the “Target Model” window.  View “Neutral Rows” region.

Fig. 12
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Fig. 13

Fig. 14



11Ozone Fading of Inkjet Prints

Ozone Fading Tutorial Tutorial 3 (Rev. 2010-01-01)

Select “sn17717_mn000.xls” in the first drop down list.
Select “Neutral Rows“ in the second drop down list. See (Fig. 14).

Observe the changes of patches in the rows with Neutral patches.

Select “sn17717_mn006_ms.xls” in the first drop down list.  See (Fig. 
15).

Fig. 15

Now that all data has been imported, close the “Target Model” window.  In 
some instances, the “Target Model” window will be opened much sooner.  For 
example, data sets imported from multiple measuring systems and associated 
software will require the “Target Model” window.

Close “Target Model” window.

Next, consider the project charts.  i-Star provides a number of easy chart-
ing options which may include spectral and hue angle distributions, i-Star 
component development and results, tonal reproduction charts, and compo-
nent histograms.  Custom specifications of the charts is possible, so becoming 
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familiar with the manual entries of factors will lead to greater efficiency.  The 
“Chart” window consists of a single page with the “Settings” and “Chart” 
tabs.  The “Chart” tab contains the chart and a lower panel with controls.  
Right-click any unused surface on the lower panel to access the chart selec-
tion menu which contain choices for all available charts.  The “Settings” tab 
contains all controls for the appearance of charts.  The individual group box 
titles indicate settings for the charts.

Press Ctrl + g or choose “Charts Window” from “View” menu.

This project considers changes for I*total, I*tone, I*color, Δe2000, hue 
angles, and L values.  The main regions of interest are the complete data set,  
neutrals, and near neutrals.  Additionally, an evaluation of differences between 
the patches with Lmax and Lmin will occur.  See (Fig. 16).

Navigate to “Settings” tab.
In the I* Component Results and Averaged Parameter Development check 

the boxes for I*total, I*tone full, I*color full, Quality Control for both I*tone 
and I*color, Brightness Factor full, and Contrast Factor full.

Navigate to “Chart” tab. Check “Show legend” box.
Choose “Adjusted Time (Yrs)” in the x axis group box.

Fig. 16
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The chart window will allow easy interpretation of both measurement and 
trend lines.  See (Fig. 17).  Click on each data point and the status bar will 
show the corresponding file and x,y coordinates.

Fig. 17

Fig. 18



14Ozone Fading of Inkjet Prints

Ozone Fading Tutorial Tutorial 3 (Rev. 2010-01-01)

This chart indicates that the region of neutral rows have deteriorated sig-
nificantly, and as much as 11.11% of the patches have a hue angle shift greater 
than 60º in the LAB color space.

i-Star can also analyze and report Δe values.  By default, all Δe values 
are calculated and presented on the corresponding tabs for each patch of the 
target measurements.  An overall value or histogram can be created for better 
analysis of results.  Observe the Δe histograms for all the patches of the target 
shown in increments of 5 for the value of Δe2000.

Right-click on the panel and select “Component Histogram” in “Context” 
menu.

Uncheck “Use complete region” check box.  See (Fig. 18).

View the worst 10% of patches, and note that those affected by very low 
levels of quality.  The most visibly affected patches on the target are those 
with lower L values and neutral patches.  i-Star may also analyze data for any 
chosen color space region of interest.  Consider the region of “Neutral Rows” 
as defined in the template.  See (Fig. 19).

Select “Neutral Rows” in the Regions of Interest drop down list.
Check the “Use complete region” check box.

Fig. 19
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View the summary of this chart with average Δe2000 values on the Com-
ponent Development chart.  See (Fig. 21).

Select “Neutral Rows” in “Region of interest” group box, and ∆E2000 in 
the “Components” group box and check “Use complete region,” and choose a 
step interval of 3.  See (Fig. 20).

Fig. 20

Fig. 21
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Right-click on the panel and select “Component Development” in “Con-
text” menu.

Observe the “Tonal Reproduction” chart for this target, and focus on the 
region of interest the “Neutral Rows” custom crop.  See (Fig. 22).

Right-click on the panel and select “Tonal Reproduction” in “Context” 
menu.

Select “Neutral Rows” in “Region of interest” group box.

Check the spectral distributions for some “Neutral Rows” patches.  Be-
cause the more affected patches, according the last chart, were the darker 
ones, analyze  how one of the “darker” patches changed.  Use the i-Star spec-
tral distribution chart.

Right-click on the panel and select “Spectral Distribution” in “Context” 
menu.

Change the column value to 9 and the row value to 11.

The tricolor chart displays overall spectral response of the target.  See (Fig. 
23).  Lower wavelengths represent the shades of blue and violet.  The center 
wavelengths represent greens, cyans and yellows.  The higher wavelengths 
represent the oranges and reds.  Observe the chart and evaluate the changes 
that have occurred.

Fig. 22
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Notice the cyan patches have also lost fidelity, so observe the spectral dis-
tribution of a cyan patch.

Change the column value to 6 and the row value to 9.  See (Fig. 24).

Fig. 23

Fig. 24
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The cyan patch lost some of the blue tones and gained small amounts of 
yellow and orange.  This explains the overall lightening of the patch and the 
slightly more yellow tone. 

 
Experiment with other row/column values and observe spectral distribu-

tion changes.

Using the i-Star User manual will help to maximize productivity when us-
ing the i-Star application.

Finally, save the project.  This allows access to data easily without having 
to reenter any information.  i-Star will save the complete set of data, a snap-
shot of the settings, and the results of all calculations.  Please note that i-Star 
will not save any open windows or generated graphs, so export either of these 
items before closing the windows.  See (Fig. 25).

Although i-Star saves all project data entered in the application, as a fur-
ther safeguard against data loss, keep the original source files and periodically 
back up all i-Star projects.

Press Ctrl + s or select “Save Project” in the “Project“ menu.
Choose a filename for the project. 
Click “Save” button.

Fig. 25

WIR i-Star contains a custom report creation utility, allowing the creation 
of PDF reports for the analyzed data.  This tutorial shows the steps taken to 
create a standard WIR report using the i-Star application.
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Click “PDF Report Preview Window” under “View” menu.

The Summary page of the PDF Report Preview window will appear.  The 
first page on the PDF will contain a summary of the project details.  The file-
name text box displays the name of the PDF.  Choose a name suitable for the 
project.  In this example, name the PDF “Ozone_report_2007_12_13.pdf.”  
The remaining three check boxes and corresponding text boxes designate the 
destination of the PDF file.  For this example, place the PDF in the same 
folder as the project.  Check the “at project folder” check box.  The remain-
ing entries, colored white, must be filled from the “Preferences” page under 
the “Project Info” tab.  These fields are not required, but provide more detail 
about the nature of the project.  All yellow fields (text boxes) may be directly 
modified from the PDF Report page.  Be sure the ‘Wilhelm Imaging style 
(short)’ radio button is checked.  This is the reporting format of a standard 
Wilhelm Imaging Research report.

The check boxes on the right side of the PDF Report Preview show which 
pages are included in the current “Report Preset” selection (in this case ‘Wil-
helm Imaging style short).  The buttons to the right of the check boxes al-
low you to preview the pages before printing the PDF.  A green label on the 
button indicates that you are currently viewing the page represented by that 
button.  In order to view a particular page, the corresponding check box must 
be checked (i.e. that page must be included in the PDF report).  Click each to 
view the PDF page. 

After reviewing the PDF preview, click “Create PDF Report” button to 
print the PDF. 

Continue exploring i-Star.  Explanations of remaining controls, including 
those for the main settings page, are available in the i-Star User Guide.  When 
done, press Ctrl + q or choose “Quit” in the “i-Star” menu.  Save any addi-
tional changes to the project.


